= VUGBERIA GANGADHAR MAHAVIDYALAYA

P.O.—BHUPATINAGAR, Dist.—PURBA MEDINIPUR, PIN.—721425, WEST BENGAL, INDIA
NAAC Re-Accredited BH.evel Govt. aided College
CPE (Under UGC XII Plan) & NCTE Approved Institutions
DBT Star College Scheme Award Recipient

-

E-mail : mugberia_college@rediffmail.com // www.mugberiagangadharmahavidyalaya ac.in

Report
of

Four days workshop for Skill Development Programme of the students

on
“Basics of Microsoft Office”

Course period: From 19" January — 24" January 2023

Organized by

Department of Zoology

(Under DBT-STAR College Strengthening Scheme, Govt. of India)

Mugberia Gangadhar Mahavidyalaya

Bhupatinagar, Purba Medinipur- 721425

ACCREDITED BY NAAC WITH GRADE B*

Affiliated to

=mmwe—  Vidyasagar University

= Principal
Mugberia Gangadhar Muhawdyalaya.




2 VUGHBERIA GANGADHAR MAHAVIDYALAYA

— P.O.—BHUPATINAGAR, Dist.—PURBA MEDINIPUR, PIN,—721425, WEST EENGAL, INDIA
2y NAAC Re-Accredited BH.evel Govt, aided College
CPE (Under UGC XII Plan) & NCTE Approved Institutions
DBT Star College Scheme Award Recipient
E-mail : mugberia_college @rediffimail.com /! www.mugberiagangadharmahavidyalaya ac.in

——

Dated: 18/01/2023
Minutes of the Departmental meeting held on 17.01.2023

Members present:
1. Dr. Kousik Kr.Mondal, HOD, SACT
2. Raju Majumdar, SACT
3. Purnima Mondal, SACT
4. Sayantika Bera, SACT
S. Sarbani Mahata, Guest Teacher
6. Subhadeep Maiti, Contractual Teacher

A short meeting was arranged at 3:15 pm regarding the implementation of short term
course on Hands on workshop on Basics Of Microsoft Office for educational
professional in our Department. All teachers of the department joined the meeting in
time. Dr Kousik Kr. Mondal (HOD) chaired the meeting.

Decisions taken in the meeting are:

(1) It is decided that Sayantika Bera will be the joint coordinator of this program and
Subhadeep Maiti will be program coordinator and rest teachers of the department

will be the recourses persons of the program. .
(2) The course period will be scheduled from 19" January to 24th January, 2023.
(3) The participation students will be UG-1" Sem, UG-3rd Sem,

(3) Course content for the said program is scheduled as
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1. How to handle Microsoft word.
2. What kinds of work done through Microsoft excel.

3. How to make power point presentation.

It is decided that the course will be delivered by lecture, interaction and PPT
presentation along with a hands on practical. There is no course access fee for the
student. HOD will forward the matter for approval of this program from Academlc
Sub-committee. Teachers are requested to prepare a routine for smooth runnmg of
course.

The meeting comes to end with a vote of thanks.
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NOTICE

Dated: 17/01/2023
Dear students,

We are pleasure to inform you that, 4 days workshop on Academic excellence Using
Microsoft office will be held on 19.01.2023 to 24.01.2023 by the Department of
Zoology of Mugberia Gangadhar Mahavidyalaya under DBT star college
strengthening scheme for Capacity Building of the students.

Our aim to cover the following points for the technical development of the students

through this skill development programme.

You will learn in this course.

. How to handle Microsoft word.

. What kinds of work done through Microsoft excel.
. How to make power point presentation.
Programme schedule

1. Microsoft Power Point on 19.01. 2023, 11:00 PM onwards by Sayantika Bera
2. Microsoft Word on 19.01. 2023, 2:00 PM onwards by Dr. Kousik Kr. Mondal
3. Practice Class, 20.01.2023, 11:00 AM onwards

4. Microsoft Excel on 20.01.2023, 2:00 PM onwards by Subhadeep Maiti

5. Microsoft Excel on 21.01.2023, 11.00 AM onwards by Subhadeep Maiti

6. Practice Class, 21.01.2023, 2:00 PM onwards

7. Practice Class, 24.01.2023, 1:00 PM onwards

%uﬁmnﬁ o 2023 w122 1¢o) 2027,
Dr. Swapan Kumar Misra Dr. Kousik Kr. Mondal
Principal HOD, Dept. of Zoology
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Department of Zoology

Mugberia Gangadhar Mahavidyalaya

Workshop
On
‘Basics Of Microsoft Office’
Learning outcomes from 1* Day, 1% Half

Course Period: 19" January 2023, 11 AM- 2.00PM

In the first half of the first day, the skill developmental program was initiated under
Sayantika Bera’s mentorship. She first delivered a brief introduction upon the basic
convenience and necessity of the Microsoft PowerPoint Presentation.

Various tools and tricks of the mentioned application were shown by her with
effective engagement. These are listed below:

1. Home: The Home tab holds
the Cut and Paste features, Font and Paragraph options, and what you need to
add and organize slides.

2. Insert: Click Insert to add something to a slide. This includes pictures, shapes,
charts, links, text boxes, video and more.

3. Design: On the Design tab, you can add a theme or color scheme, or format the
slide background.

4. Transition: Set up how your slides change from one to the next on
the Transitions tab. Find a gallery of the possible transitions in the Transition to
This Slide group — click More at the side of the gallery to see all of them.

5. Animation: Use the Animations tab to choreograph the movement of things on
your slides. Note that you can see many possible animations in the gallery in the
Animation group, and see more of them by clicking more.

6. Slide Show: On the Slide Show tab, set up the way that you want to show your

presentation to others.




8. View: Views allow you to look at your presentation in different ways,
depending on where you are in the creation or delivery process.

9. File: At one end of the ribbon is the File tab, which you use for the behind-the-
scenes stuff you do with a file, such as opening, saving, sharing, exporting,
printing and managing your presentation. Click the File tab to open a new view
called the Backstage. Click from the list on the side to do what you want to do;
for example, click Printto find the options and settings for printing your
presentation. Click Back to return to the presentation that you were working
on.

10.Tool Tabs : When you click some parts of your slides, such as pictures, shapes,
SmartArt or text boxes, you might see a colorful new tab appear.

I'l. Others : In the example above, the Drawing Tools tab appears when you click
a shape or text box. When you click a picture, the Picture Tools tab appears.
Other such tabs include Smart Art Tools, Chart Tools, Table Tools and Video
Toois. These tabs disappear or change when you click something else in your

presentation.
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Mugberia Gangadhar Mahavidyalaya
Department of Zoology
Date: 19/01/2023
Workshop

On
‘Basics of Microsoft Office’
Course Period: 19" January 2023, 2:00 PM onwards

Brief description of the course on ‘Microsoft Word Application’

The objective of this course is to learn about the various tools of Microsoft Word
application. It will enable the students to perform various works related to
demonstration and analysis of data in corporate fields as well as in research fields. The
mission of this course is to build the skills related to Microsoft office.

Whichever excellencies students pursue, a solid grasp of Outlook is likely to come in
very handy. The ability to manage demonstrative works and tasks will help them
stay organized and productive thus Supporting the students by helping them sharpen

their technical skills in Microsoft Office.

Objectives of the Course:

In this course, student will be able to

« Indicate the names and functions of the Word interface components.

» Create, edit, save, and print documents to include documents with lists and

tables.
» Format text and to use styles.
« Add a header and footer to a document.
« Add a footnote to a document.
» Add a graphic to a document.

« Knowing the advantages of grammar solutions while scripting.




 Manipulate documents using functions such as find and replace; cut, copy,

replace etc.

The class was taken by Dr. Kousik Kr. Mondal as per the notice.

Learning Outcomes from First Day, 2" Half

Key Learning:

1. Format text
The Formatted text has commands to perform formatting tasks which are found on the
home tab in the font group. When we want to format the text then first we have to
select the text which we want to format, if want to format a single word then double
click on it, we can also select a line of text, and then select an option to change the
font, font size and we can make the text bold or italic or underline. In formatting text,
head style, can make words bold text or italic text, also can underline the text,
highlight the text, can make an unordered list and ordered list, we can change
alignment as left or right or at the center.

2. Insert hyperlink(link)
The hyperlink in a document
has a different color than
other texts and it is
underlined. A hyperlink in a
document helps the reader to

Jump from one place in the Bhupati Nagar, West Bengal, India

Mugberia Gangadhar Mahavidyalaya, 2P2H+6C7, Bhupati

gal 721425, India

document to a different file or

website or go to the new
3 PM GMT +05:30

emails.

We can add or delete hyperlinks in the word document. If we want to add a link in the

document, first we have to select text or image which want to link, then right-click on




on the version, after that, we have to select the type of destination which we want to
link, it has some information that has to fill correctly, choose an option ‘Existing file
or Web page’, go to the ‘Address’ text box then enter URL, then choose ‘Place in this
document and select a location within the document, so now click on ‘Create new
document’ go to the text box ‘Name of the document’ and enter the name, there is an
edit section in which we can choose whether we want to edit the document now or
later.
Then choose ‘Email address’ and click on the text box of ‘Email address’ then we can
enter the email address to which the reader can send an email. There is also a ‘Type of
subject’ option we can subject type and then click on ‘Ok’. The text now shows up as
a hyperlink in the document.

4. Edit and Remove links
For editing the link first select the link which we want to edit and then select the
Insert/edit link option, update the web address and then click on the ‘Create link’. We
can remove or delete the existing hyperlink, for deleting the hyperlink right-click on it
and click on the ‘Remove hyperlink’.

3. Copy and paste from word
The copy and paste function from the word we can use to remove the hidden
Microsoft characters which may affect how our document will appear. To select and
copy the word content, click on the ‘Paste’ special function button, select or tick on
the bullet ‘Paste from Microsoft word’ then paste our word text in the text box and
then click on ‘Complete paste’.

6. Add a table
A table is a combination of rows and columns and the intersection of rows and
columns is called a cell. To create or insert a table in the document click on the
‘Insert’ tab which is on the ribbon then click on ‘Table’, the insert table window will
be opened, we have to select the size of the table in columns and rows, and then click
on ‘Ok’. When the table is created the ‘Tab’ key can be used to move from one cell to
the other, by pressing the tab key new row is created, if we want to move one

cell back in the table then we can ‘Shift+Tab’ keys, the arrow }(’ V!

Y

we to go up,

down, left, right.
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7. Edit a table
Microsoft word editing tools allow us to edit a table, if we want to edit a table then
first we have to select a cell in which we want to edit then click on the table icon it
will give some options out of them select ‘Edit table’ so that we can change the
general setting of the table. While editing if we want to add a new row then click on
the insert below or insert above, for adding the column click on the insert left or insert
the right column button. We can also delete columns or rows from the table.

8. Html editor
We can also edit our text by using Html editor, this function is also provided by
Microsoft word editing tools. To get the Html view and to edit text, click on the ‘File’
tab then click on ‘Open’, then we can browse the web page file, double click on the

file name, our web file opens as a plain text file which has Html code.
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Department of Zoology

Mugberia Gangadhar Mahavidyalaya

Workshop
On
‘Basics of Microsoft Office’

2"" and 3™ Day of Coursework (20.01.2023 & 21.01.2023)

In the next day, the rest curriculum of the Workshop on was continued by Subhadeep
Maiti. At initiation, an introductory speech was delivered by him accounting the

advantages and necessities of the various aspects of Microsoft Excel application.

Various kinds of tools including the operational system of excel interface was
exhibited with effective applications by the Mentor Subhadeep Maiti. These are
listed briefly here:

I. Cells and Worksheets: The basic building blocks of Excel are cells and
worksheets. Cells are individual boxes where data can be entered or edited, and
worksheets are individual tabs where collections of cells can be organized and
analyzed.

2. Create & edit a table: Excel allow us to create & edit a table, if we want to
edit a table then first we have to select a cell in which we want to edit then
click on the ‘format table’ so that we can change the general setting of the
table. While editing if we want to add a new row then click on the insert below
or insert above, for adding the column click on the insert left or insert the right
column button. We can also delete columns or rows from the table.

3. Formulas and Functions: Excel has a wide range of built-in formulas and
functions that allow users to perform calculations on data within cells. Some of
the commonly used functions include TRANSPOSE, C _
AVERAGE, MAX, MIN, COUNT,
STANDARD ERROR and IF FUNCTION.

12



Charts and Graphs: Excel offers a variety of chart and graph types that can be
used to visually represent data. These include column charts, line charts, pie
charts, scatter plots, and more.

. Conditional Formatting: Excel allows users to apply formatting rules to cells
based on specific conditions, such as highlighting cells that contain a certain
value or formatting cells based on their color.

. Filters and Sorting: Excel has tools that allow users to filter and sort data
based on certain criteria, making it easier to analyze large datasets.

Data Validation: Excel has features that allow users to create drop-down lists,

restrict data entry to certain types of values, and prevent duplicates.
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Department of Zoology

Mugberia Gangadhar Mahavidyalaya

Workshop
On
‘Basics of Microsoft Office’

Practice Class for Students (20.01.23, 21.01.23 & 24.01.23)

On 20", 21" & 24" January the students engaged in practicing the tools which were
shown by the respective teachers before days. The students used the IT Laboratory of
Department of Mathematics to perform and rehearse their skills. Under the
supervising and guidance of Subhadeep Maiti, Sayantika Bera, Sarbani Mahata and
Raju Majumdar the two days practice was carried out where they were engaged in
helping the students with their problems.

The students of both 1™ Sem and 3™ Sem were involved in the practicing. They
experienced hand on tooling of Microsoft Office Tools while they did several tasks

provided by the respective mentors,
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Mugberia Gangadhar Mahavidyalaya

Workshop on
On
‘Basics of Microsoft Office’

Test Regarding the Skill Development Program

To implement the development of acquired skill by the students, A test was conducted
on 24" F ebruary, 2023 by the course coordinators. The test was performed at the IT
Lab of Department of Mathematics with their positive permission. A total number of
31 students from UG 1* Sem and 20 students from UG 3™ Sem participated at the test

positively.

Three different set of questions were set from Microsoft Office Word, Excel and

PowerPoint. The grades were given as per candidates’ performance on their skills.
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Participants along with gradation in the examination:

SL.NO Name Grade |
1 Shipra Jana AA
2 Arpita Maity AA
3 Somrita Paria B
4 Keshab Chandra Nayak AA

B Monalisha Maity JAN
6 Arindam Das | | AA
7 Ritam Maity AA
8 Saheli Mandal TAA
9 Dolan Maity B
10 Rituparna Bera AA
11 Soumyajit Pal B
12 Susmita Khatua AA
13 Purnima Jana " .' A
14 Priti Gt C
15 Sathi Nanda A
6 ~Sthgmi Gharai A
17 Uma Jana A
18 Sunita Dalapati A
19 Arup Kumar Mondal A
20~ Dibyendu Giri A
21 _. Mousumi Bhakta AA
22 Debosmita Nanda AA
23 Anima Gole AA
24 Anindita Gole A
25 Sanjib Matia C
26 Sangita Lal AA
27 Paramita Samanta AA
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28 Sovan Kar AA
29 Pritama Khatua A
30 Arnab Barman AA
31 Soumyadip Mandal A
32 Rudraprasad Das AA
33 Agamani Jana AA
34 Sunita Bhunia AA
35 Tridip Gayen B
36 Sananda Hazra
37 Rajashree Panda AA
38 Rimpi Samanta AA
39 Karna Tudu AA
40 Manjima Bar AA
41 Moumita Das A
42 Krishna Bera A
43 Sonali Nanda C
44 Piyali Sasmal A
45 Ankita Jana B
46 Trisha Bag C
47 Sunanda Maity (8!
48 Purnima Das C
49 Satyajit Maity C
50 Suvankar Das C
51 Jayashree Jana €
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OUTCOME

In the Workshop on Microsoft Office Skills initiated by the Department of Zoology,
Mugberia Gangadhar Mahavidyalaya is a valuable opportunity for students and
professionals alike to improve their proficiency in using this essential software tool.
Through this course, participants will gain hands-on experience with the various
features and functions of Microsoft Word, including formatting, editing, document
design, and more. These skills are not only critical for success in academic and
professional settings, but also for personal use in creating and sharing documents.
Overall, this course represents an important investment in the development of skills

that will benefit participants throughout their careers and beyond.
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WORKSHOP {
ON : _':i._ e b .
BASICS OF MICROSOFT OFFICE o
19TH -24TH JANUARY, 2023
Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR:: WEST BENGAL:: 721425

CERTIFICATE OF COMPLETION

Note: ﬂzgnﬁsmﬂus;ﬂﬁ-.ﬂ&ﬂ-&&f&ﬁ&d&

Earvo-
SUBHADEEP MAIT] SAYANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR
L UTT G D) - ertora—
DR. KOUSIK KR. MONDAL DR.SWAPAN KR. MISRA

HOD, ZOOLOGY PRINCIPAL
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Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR:: WEST BENGAL:: 721425

r&

CERTIFICATE OF COMPLETION

Note: MMMQW;MMA:ZI-&&IG& C:<I6.

. (="
SUBHADEEP MAITI SAYANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR

kow? ’ P
DR. KOUSIK KR. MONDAL DRSWAPAN KR. MISRA

HOD, ZOOLOGY PRINCIPAL
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19TH -24TH JANUARY, 2023

Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR: WEST BENGAL- 721425

CERTIFICATE OF COMPLETION

Nou:??nguhsmasm;.ﬂ:m&ﬂ~$; B:16-20; C:<16.

R &
SUBHADEEP MAITI SAYANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR

wans I ZomSlad
DR. KOUSIK KR. _MGN_I‘)&L
HOD , ZOOLOBY

ROAT—
DRSWAPAN KR, MISRA
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Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR;PURBA MEDINIPUR: WEST BENGAL: 721425

D

CERTIFICATE OF COMPLETION

Note: ﬂsgnhmwﬂus;MMA:ﬂ-ﬁ&fb‘-ﬂk& <I6.

e
SUBHADEEP MAITIL SAYANTIKA BERA
COURSE COORDINATOR JOINY COORDINATOR
ot -
DR, KOUSIK KR, MONDAL DIRSWAPAN KR. MISRA
HOD , ZOOLOGY
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19TH -24TH JANUARY, 2023

Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR: WEST BENGAL: 721425

CERTIFICATE OF COMPLETION

Mmﬂugﬂsmaﬁﬁ:us;d&:m&ﬂ-ﬁ&}&w;(} <I6.

Sifco--
SUBHADEEP MAITI SAYANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR
U.-u.| conbad

DISWAPAN KR. MISRA
PRINCIPAL

DR. KOUSIK Kit. MONDAL
HOD , ZOOLOGY

36



WORKSHOP
ON
BASICS OF MICROSOFT OFFICE
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Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR: WEST BENGAL: 721425

g

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16.

SUBRHADEEP MAITI SAYANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR
U-u ST Covdeled
DR. KOUSIK KR, MONDAL DR.SWAPAN KR. MISRA
HOD , ZOOLOBY PRINCIPAL
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ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR:: WEST BENGAL: 721425

CERTIFICATE OF COMPLETION

Note: The gradesare s follows; AA: 26-30; A: 21-25; B: 16-20; C:<I6.

& @
SUBHADEEP MAITI SAYANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR

DR. KOUSIK KR. MONDAL DR.SWAPAN KR. MISRA

HOD , ZOOLOGY
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SUBHADEEP MAITI SAYANTIKA BERA
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CERTIFICATE OF COMPLETION
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@Gevoe-
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Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR::PURBA MEDINIPUR:: WEST BENGAL: 721425

CERTIFICATE OF COMPLETION

Note: The gradesare asfollows; Ad: 26-30; A: 21-25; B: 16-20; C:<I6.
';...‘6-’

SUBHADEEP MAITI SAYANTIKA BERA

COURSE COORDINATOR JOINT COORDINATOR
. ' / %m—f
DR. KOUSIK KR. MONDAL DR.SWAPAN KR. MISRA
'HOD , ZOOLOGY PRINCIPAL
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BHUPATINAGAR:PURBA MEDINIPUR:: WEST BENGAL:: 721425

»

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16.

SUBHADEEP MAITI SAYANTIKA BERA

COURSE COORDINATOR JOINT COORDINATOR
e T Zov@lad _
DR. KOUSIK KR. MONDAL DRSWAPAN KR. MISRA

HOD, ZOOLOGY PRINCIPAL
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Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR: PURBA MEDINIPUR: WEST BENGALL 721425

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16.

:
suan'&muw MAITI SAVANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR
W u STzl Baotren—"
DR, KOUSIK KR MONDAL DRSWAPAN KR MISRA

HOD , ZOOLOGY
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Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR: WEST BENGAL: 721425

8

ot

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16.

SUBHADEEP MAITI SAYANTIKA BERA

COURSE COORDINATOR JOINT COORDINATOR
PRV, o SO | R0
DR. KOUSIK KR. MONDAL DRSWAPAN KR. MISRA

HOD , ZO0LOGY
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19TH -24TH JANUARY, 2023

Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR::PURBA MEDINIPUR; WEST BENGAL: 721425

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16

SUBHADEEP MAITI SAVANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR
P . hedoeon—
DR. KOUSIK KR. MONDAL DRSWAPAN KR. MISRA
HOD , ZOOLOGY
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Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR: WEST BENGAL: 721425

@

CERTIFICATE OF COMPLETION

This is to certify that, Mr. /Mrs. LluzuaLim

a student (f the Depai .
T
r pa

participated and completed a four-day

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16.

SUBHADEEP MAITI SAYANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR
et T2 _ W
DR. KOUSIK KR. MONDAL DRSWAPAN KR. MISRA
HOD , ZOOLOGY PRINCIPAL
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Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR: WEST BENGAL: 721425

/&

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30: A: 21-25; B: 16-20: C: <I6.

@hovo. .
SUBHADEEP MAITI SAYANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR

u—-u-“rc.-@-.!
DR. KOUSIK KR, MONDAL

HOD , ZOOLOGY

DR.SWAPAN KR. MISRA
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Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR:: WEST BENGAL: 721425

(

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16.

Sue¥ o
SUBHADEEP MAITI SAYANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR

we w-w Senorer—

DR. KOUSIK KR. MONDAL DR.SWAPAN KR. MISRA

HOD, ZOOLOGY
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Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR:: WEST BENGAL: 721425

g\

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16.

ol o

SUBHADEEP MAITI SAYANTIKA BERA

COURSE COORDINATOR JOINT COORDINATOR
PPEVEy o A e B e oevrra——

DR. KOUSIK KR. MONDAL DRSWAPAN KR. MISRA

HOD , ZOOLOGY
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Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR::PURBA MEDINIPUR:: WEST BENGAL: 721425

B

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16.

Buats @
SUBHADEEP MAITI SAYANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR

DR. KOUSIK KR. MONDAL DR.SWAPAN KR. MISRA

HOD , ZOOLOGY
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Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR-PURBA MEDINIPUR: WEST BENGAL= 721425

@

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16.

Dot EBemn.

SUBHADEEP MAITI SAYANTIKA BERA

;::'En!;s COORDINATOR JOINT COORDINATOR
e ST Za Rl evtren—

DR. KOUSIK KR. MONDAL DRSWAPAN KR. MIS

HOD , ZOOLOGY PRINCIPAL
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CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20: C:<16.

J % SAYAN’I‘IK'; BERA
SUBHADEEP %A:g; s

wotrs Y nnldand
DR. KOUSIK KR. MONDAL
HOD, Z00LOGY
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Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16.

s @ovo.
SUBHADEEP MAITI SAYANTIKA BERA
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w u.w guim._
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5

CERTIFICATE OF COMPLETION

oty e, 2l ity

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20: C: <16.

SUBHADEEP MAITI SAYANTIKA BERA
COURSE COORDINATOR JOINT COORDINATOR
k.es s L 3 T
DR. KOUSIK KR. MONDAL DRSWAPAN KR. MISRA
HOD , ZOOLOGY PRINCIPAL

63



WORKSHOP |

ON =

BASICS OF MICROSOFT OFFICE il
19TH -24TH JANUARY, 2023

Under DBT-STAR College Strengthening Scheme

ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BNUPATINAGAR PURBA MEDINIPUR: WEST BENGAL: 721425

CERTIFICATE OF COMPLETION

Note: The grades are s follows; A4: 26-30; A: 21-25 B:16-20; G <16:
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Under DBT-STAR College Strengthening Scheme
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MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR::PURBA MEDINIPUR:: WEST BENGAL: 721425

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16.
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DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR: WEST BENGAL: 721425

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20: C:<16.
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MUGBERIA GANGADHAR MAHAVIDYALAYA
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CERTIFICATE OF COMPLETION

Noze: The grades are as follows ; A4: 26-30; A: 21-25; B: 16-20: C: <16.
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MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR::PURBA MEDINIPUR:: WEST BENGAL:: 721425

CERTIFICATE OF COMPLETION

ON L

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C: <16.
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BHUPATINAGAR::PURBA MEDINIPUR:: WEST BENGAL: 721425

CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20; C:<I6.
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ORGANISED BY
DEPARTMENT OF ZOOLOGY

MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR::PURBA MEDINIPUR: WEST BENGAL: 721425

CERTIFICATE OF COMPLETION

Note: The grades areas follows ; AA: 26-30; A: 21-25; B: 16-20: C: <I6.
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BHUPATINAGAR:PURBA MEDINIPUR:: WEST BENGAL:: 721425

CERTIFICATE OF COMPLETION
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MUGBERIA GANGADHAR MAHAVIDYALAYA

BHUPATINAGAR:PURBA MEDINIPUR: WEST BENGAL: 721425
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CERTIFICATE OF COMPLETION

Note: The grades are as follows ; AA: 26-30; A: 21-25; B: 16-20: C: <16
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Certificate Distribution

We completed our programme with certificate distribution where our honourable
Principal sir and departmental teachers were present and concluded this programme

successfully.
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